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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-
ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN
30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer. You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time. You shall not
install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any
other hardware configuration where the SOFTWARE is accessible to more than one CPU or
to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN
WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes,
or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your
computer and retain the original for back-up purposes. Any other copying of the
SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright
notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support
for use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions
or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS
LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-
ROM storing the SOFTWARE is warranted only against defective material under normal use
for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be
replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection. The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE
INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED
OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE
THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You
may terminate this Agreement by destroying the SOFTWARE. This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE. In addition, Canon may enforce its
other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer
Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles. The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use
of the SOFTWARE is subject to the United States, Canada and other applicable copyright
and trademark laws and nothing in this Agreement constitutes a waiver of the rights of
Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY
ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Introduction

This chapter includes information on the precautions to be read before using
EOS Utility, how to use this Instruction Manual, the system requirements and
the supported image types. It also explains the software features and
configuration.

About This Manual

Thank you for purchasing this Canon product.

Precautions for using this product safely and icons to help you with procedures, etc. are
described at the beginning of this Instruction Manual. Please be sure to read these first before
proceeding to the information in the other chapters.

© ltis prohibited to reproduce, in whole or part, the contents of this Instruction Manual
without permission.

Canon may change without notice the software specifications and contents of this
Instruction Manual.

The software screens and displays printed in this Instruction Manual may differ slightly
from the actual software.

The content of this Instruction Manual has been reviewed thoroughly. However, if you
should notice any errors or omissions, please contact a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does not take responsibility
for the outcome of the operation of the software.

Trademark Acknowledgments

© IBM is a registered trademark of International Business Machines Corporation.

® Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

© Other names and products not mentioned above may be registered trademarks or
trademarks of their respective companies.

© Click on the item to display its page.

About ThisS ManUAL ..o s s s an e e nnns 0-1
System ReqUIremMents ..ot 0-1
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How to Use This Instruction Manual...........ccooiiiioiiinii e 0-2
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Compatible Models and Supported Images

This software supports the following cameras and images.

oS Windows XP (Professional/Home Edition), Windows 2000
c t Ctomj)utderfwitth one of tgeHaCtiove O? prtelilr;sEtEI:%cé:nd: USB port as a Setting the Cameras
omputer standard feature or an -complian po
* Upgraded machines not supported. Othpfrthan the EOS-1D
- : Series Cameras
CPU 750MHz Pentium Il or higher
RAM Minimum 256MB
Interface USB 1.1 to 2.0 Hi-Speed or IEEE1394 .
Displa Screen resolution: 1024 x 768 pixels or more Setﬁ'"g the EOS-1D
play Color quality: Medium (16 bit) or more Series Cameras

Supported Cameras Supported Images

Remote Shooting

EOS-1D Mark IIN | EOS 20D

EOS-1Ds Mark I | EOS 10D

EOS-1D Mark Il | EOS DIGITAL REBEL XTi400D DIGITAL | W and JPEG images
EOS-1Ds EOS DIGITAL REBEL XT/350D DIGITAL | shot with the camera on
EOS-1D EOS DIGITAL REBEL/300D DIGITAL the left

EOS 5D EOS D60

EOS 30D EOS D30

Troubleshooting

Index
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How to Use This Instruction Manual

Click to move to the Square brackets [ ] are used to indicate items such as menu names, button names and Cove r/Table Of
beginning of each chapter. window names that appear on the computer screen.

| Contents

Canon EOS Utility Instruction Manual M[ Downloading Images from Your Camera Introduction
C fTable of
Downloading All the Images in a Single Operation Dawnloading Images to Your Computer by Operating the Camera
- ey iy iorshvor T g
SEOS Utility 1.1 s T o et 8 31 05 DAL 6D
1 Downloading Images from the Camera m::émlmqu ::“‘:"“‘"“"“'“"‘ Connect the camera and the computer and then start EOS Usility T Images Downloading |mages
Compatible Models . Ttk ey sty o e g
: P ‘ Partom diesct mage tranor on the camers. from the Camera
*EOS-1D Mark IN = EOS 30D Setting the Cameras other than the ‘Seting the Cameras When sl ha images hava baen Tha images fromth camars ses saved b hs compuer
*EOS-1Ds Mark I = EOS 20D 2 £05-10 Seres Cameres o G :&%‘:{i&:rii:: g'.-::.'a'.':-.:...- i sty i L
+EOSADMarkll  «EOS 10D e o o
*EOS-1Ds = E08 DIGITAL REGEL ATHO00 IGTAL 3 Setting the EOS-1D Series Cameras e e ooyl isintapetl I e o Setng he EOS-1D - ~
L il EOS Uiy ard Ban s 1ha camars's | . o .
+E08-1D  E0S T AL 00T S Sre &‘?mmﬁm Setting the Cameras
. ~himCredeae on
o Cosoer 4, Raroe sraoing 4 S, otherthan the EOS-1D
*E08 D30 | R e e Series Cameras
Troubleshooting Troubleshooting ok e e 7k B [Pk 5o, : 1 L
[ Vou can ctmnga e sctwar t1at siets up witen you dowrioad images, fram
ZoomBrowsar EX fo Dighal Photo Professlonal (p 4-5). Hawaver, i you have
Index Index o Tk A TS e i e B Index r N
Setting the EOS-1D
How to use this manual Serles Cameras
s 000 .000
Click to move to the previous page. :Marks additional information
that you will find helpful. .
Click to move to the next page. Remote Shootlng
Click iously displaved :Marks information that should be read before Reference page numbers are indicated in blue
ick to return to previously displayed page. use to prevent problems that would interfere either in brackets () or within text. Click on the L
with the functioning of software and computer. page number to move to the corresponding page.
@ In this manual, Windows XP Professional/Home Edition is referred to as “Windows XP” © The camera name is shown in the screens as “EOS XXX". TI’OU bleShOOtmg
and Windows 2000 Professional is referred to as “Windows 2000”. © Descriptions of camera operations assume that the reader is familiar with the L
© For more information on the restrictions of EOS Utility, refer also to the source listed information in the camera’s Instruction Manual.
below. © In this manual, the screens used in the examples are from Windows XP. [ )
Readme: Click the [Start] button P select [All Programs] ([Programs] in Windows 2000) © Text inside < > in this document indicates the keys on the keyboard and camera button IndeX
» [Canon Utilities] » [EOS Utility] » [EOS Utility Readme]. names.
@ P in this document indicates the sequence of Window®  Help(H) L

operation as shown on the right. Disolerlize  I—
Example: [View] menu P> [Display Size] P> [Large] Imsge Informstion O Gtrl+1

SmallS}  Gtril
+2

0-2



Software Main Features and Configuration

Canon Digital Camera software having the following features and functions is stored

on the EOS DIGITAL Solution Disk. Operation is done as shown on this page together with
each software application, centered around EOS Utility.

e==) : Shows the shot image flow.

== : Shows the camera control information from the software.

Cover/Table of
Contents

: Shows software windows and descriptions of operation explained in this manual.
: Shows the Digital Photo Professional and ZoomBrowser EX windows and description of each operation.

Introduction

EOS Utility (Software for the Camera) - N

Downloading Images
from the Camera

@ Communicates with the camera to
download to your computer images saved
on the memory card inside your camera,

7 E0S Utility - Canon EOS XxX

Download image
(p.1-6)

and can transfer images to Digital Photo L
o Professional or ZoomBrowser EX (p.1-6).
@J Starts to download images @ You can download multiple images in a ( . )
B e s st single operation, display images as a list Setting the Cameras

and download only selected images (p.1-6
to p.1-7).
@ You can perform various settings for your
camera (p.2-1, p.3-1).
© You can shoot photos by controlling the . =
camera from your computer and download
images to your computer (p.4-1). Setting the EOS-1D
Series Cameras

. otherthanthe EOS-1D
Camera settings Series Cameras
(p.2-1, p.3-1)
Remote shooting

(p-4-1)

Transfer downloaded images (p.1-6) L
Transfer remotely shot images (p.4-1)

Remote Shooting

ZoomBrowser EX (Image Viewing and Editing Software)

@® Software recommended if you

Digital Photo Professional (RAW Image Viewing and Editing Software)

=0 @ Software recommended if you

mainly shoot RAW images.
Coupled with high-speed display

and processing of RAW images, (procedure) of downloading, TrOU bleShOOtmg
you can edit RAW images with a viewing, editing, and printing

variety of adjustment functions. images. L

(You can also display and edit For detailed instructions on P =
JPEG images.) ZoomBrowser EX, refer to the

For detailed instructions on Digital “ZoomBrowser EX Instruction | ndex

Photo Professional, refer to the
“Digital Photo Professional
Instruction Manual”.

mainly shoot JPEG images and
can perform a standard workflow

Manual”.
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1 Downloading Images from the Camera

This chapter explains preparations necessary to download images from your
camera to your computer, and downloading methods. It also explains how to
download images using a third-party card reader.

© Click on the item to display its page.

Prepare to Download IMages ..........cccovimmiiiinnssis s 1-2
Setting a Camera with [Communication] Settings...........ccccooveveiiiiiiiencnn 1-2
Connect the Camera and the Computer and then Start EOS Utility............. 1-3
Connecting a Camera other than an EOS-1D Series Camera to Your Computer.. 1-3
Connecting an EOS-1D Series Camera to Your Computer............cccceeeeenee. 1-4
Precautions When Connecting the Camera and Computer...........cccccecoveenee. 1-5
Downloading Images from Your Camera ..........cccucerinmissnnessssssssssssssssnsssanes 1-6
Downloading All the Images in a Single Operation...........ccccocveeviiiiiiicnnnen. 1-6
Downloading Images to Your Computer by Operating the Camera................ 1-6
Downloading Selected IMages ...........cccociiiiiiiiiiiiiieee e 1-7
Downloading JPEG Images Using the PTP Function ..........ccccccviiiieniiiininnns 1-8
Downloading for Cameras other than the EOS-1D Series Cameras.............. 1-8
Downloading with EOS-1D Series Cameras. ..........cccvoveeriieeeiieeeniee e 1-8
Precautions for the PTP FUNCHON ..........ccooviiiiiiiiiiec e 1-9
Downloading Images Using Your Card Reader............cccuviminimnnninennsiennnnanns 1-9
Transferring the Images in a Specified Folder .........cccoovniiiirininnncieiieens 1-10
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Prepare to Download Images

o oo L _ ; Cover/Table of
H H H H : en setting the [Communication], always ensure that the camera is not connecte
Settlng a Camera WIth [Communlcatlon] Settlngs to the computer beforehand. Setting the [Communication] while the camera is Contents
For a camera with [Communication] included as a menu function, you can communicate with connecte.d to the computer will cause camera and software malfunctions.
EOS Utility to download images to your computer by selecting a [Communication] setting. When using the EOS 5D or EOS DIGITAL REBEL XT/350D DIGITAL, the remote , \
The setting on this page is necessary for the EOS 5D, EOS 30D, EOS 20D, EOS 10D shooting function and camera setting function in EOS Utility cannot be used if the ,
EOS DIGITAL REBEL XT/350D DIGITAL and EOS DIGITAL REBEL/300D DIGITAL. EEEELS [[CommL ez e (5 S2t o [P, o Introduction
For cameras other than the above, it is not necessary to perform settings for the Wiz sl s SR S, dhie @i s sine 209 Ll esiuel somliles s 07 s
camera. Continue with the procedure in “Connect the Camera and the Computer and camera’s [Communication] is set to [LAN (WFT-E1)].
then Start EOS Utility” (p.1-3). When using the EOS 20D, EOS 10D or EOS DIGITAL REBEL/300D DIGITAL, the
camera and EOS Utility cannot communicate if the camera’s [Communication] is set
to [PTP]. Downlo glmages
Check that the ,camera IS m_)t connected to the computer and then With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details from the mera
set the camera’s power switch to <ON>. on changing, refer to the Canon’s web site.
Set the camera’s [Communication]. r \
i Setting the Cameras
With the EOS 30D, set [fT Communication] Operation window in the EOS 30D About the PTP Settlng 9

otherthanthe EOS-1D

in menu to [Print/PC]. .
[ : Series Cameras

When using Windows XP, you can also download JPEG images that use the PTP (Picture

Set the [Communication] for other ¢t Transfer Protocol) function (p.1-8).

cameras in the same procedure as the Date/Time i ( J
EOS 30D, using the following for a File numbering 3 -
reference. Language

Video system Setting the EOS-1D

Communication »Print/PC Series Cameras
Format LAN(WFT-E1) [& |

Custom Function

[Communication] settings for different cameras

Camera model Menu N @ng Remote ShOOting

EOS 5D [¥T Communication] [PC connect.]
EOS 30D [T Communication] [Print/PC]
EOS 20D [¥T Communication] [Normal] )
EOS 10D [Communication] [Normal] Trou b|eshooting
EOS DIGITAL REBEL XT/350D DIGITAL [¥T2 Communication] [PC connection]
EOS DIGITAL REBEL/300D DIGITAL [¥T2 Communication] [Normal]

Press the <MENU> button to switch the LCD monitor display off Index

and then set the camera’s power switch to <OFF>.

. QOO



Connect the Camera and the Computer and then Start EOS Utility

. . Select [Canon EOS Utility] and then click the [OK] button. Cover/Table of
Connecting a Camera other than an EOS-1D Series Camera to Your Computer £05 Uty starts up and the camera’s RGN 5 Contents
Connection procedure for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL ready to communicate with your computer. P
REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, EOS DIGITAL REBEL/ Proceed to “Downloading Images from )
300D DlGlTAL, EOS D60 and EOS D30 Your Camera” (p1—6) Select the program to launch for this action: O
Before downloading images to your computer or specifying the camera settings, you must For Windows 2000, a [Event on device] Canon Camerawindaw IntrOd UCt|On
connect the camera to your computer with the interface cable supplied with the camera. dialog box appears. Select [Canon EOS s e L LA e
You car‘1 conngct the camera thlle your compl.Jter is running. Utility] and then click the [OK] button to (@ — .;:ar.-.g,
For instructions on connecting EOS-1D series cameras and your computer, refer to the next start up EOS Utilit
page. p Y- ~7 2 Microsoft Scanner and Camera \Wizard
Download pictures from a camera or scanner Downlo g Images
. . from the €amera
Plug the dedicated cable into the computer.
[ &hirays use this program for this action
Plug the cable into the USB port. ~
Refer to the computer User’s Manual for Lo ) cocd | ( )

Setting the Cameras
The procedure in steps 3 and 4 is only 3 EOS Utility - Canon EOS XXX otherthan the EOS-1D
necessary when connecting the camera B ey Series Cameras

and your computer for the first time. From L

the next time you connect to your
computer, EOS Utility will start up when
you set the camera’s power switch to s e Setting the EOS-1D
<ON>in step 3. a Starts to download images Series Cameras

information on the terminal areas.

Press the camera’s button

f

ey

/
t

Plug the dedicated cable into your camera.

P

Lets you select and download images

Face the << > mark on the plug to the

front of the camera and connect the plug = /Shoot remetel
: _ — e — 4 ~
to the camera’s < DIGITAL > terminal. % e et etattars

Remote Shooting

1§
I

&

Monitar folder and import images

Monitor Folder

&

, ~
Set the camera’s power switch to <ON>. The above window shows information displayable when EOS 30D or EOS DIGITAL TrOU bIeShOOtmg

REBEL XTi/400D DIGITAL is connected. The displayed information varies depending
on the camera model connected.

el

on |
OFIT \/

&J
=]
)

@ If [EOS Utility] does not start up even after performing step 4, double-click the [EOS IndeX
Utility] icon on your computer’s desktop, or click the [Start] button B> select [All Programs]
([Programs] in Windows 2000) P [Canon Utilities] » [EOS Utility] » [EOS Utility]. L J

Communication between the camera and
your computer starts. At first the pop-up
menu on the right appears, and then the
dialog box in step 4 is displayed.

For Windows 2000, a dialog box such as [Found New Hardware] may appear. @ @ @
1-3




. . Select [Canon EOS Utility] and then click the [OK] button. Cover/Table of
Connecting an EOS-1D Series Camera to Your Computer EOS Uity starls up and the camerais  [rsgmem 5 Contents
Connection procedure for the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D Mark II, EOS- ready to communicate with your computer. {5 " "
1Ds and EOS-1D Proceed to “Downloading Images from r 2
Before downloading images to your computer or specifying the camera settings, you must Your Camera” (p.1-6). Select the program ta launch for this action: .
connect the camera to your computer with the dedicated IEEE1394 interface cable supplied For Windows 2000, double-click the [EOS Canon Camerawindows IntrOd UCt|On
with the camera. You can connect the camera while your computer is running. Utility] icon on your computer’s desktop to e
For instructions on connecting cameras other than the EOS-1D series cameras and your start up EOS Utility. (@ on E0S Ui M- '-'r"r
computer, refer to the previous page. —
~7 2 Microsoft Scanner and Camera \Wizard
Download pictures from a camera or scanner Downlo g Images
Plug the dedicated cable into the computer. from the €amera
Plug the cable into the IEEE1394 port. [ &hways use this program for thiz action
Refer to the computer User’s Manual for [ o ]‘ Cancel ; .
information on the terminal areas. .
Setting the Cameras
The procedure in steps 3 and 4 is only 7 E0s Utility - FOS XXX X otherthanthe EOS-1D
necessary when connecting the camera Downioads using computer Series Cameras

and your computer for the first time. From
the next time you connect to your
computer, EOS Utility will start up when

Plug the dedicated cable into your camera. jou S the camera’s power switch to et s Setting the EOS-1D
<ON>in step 3. Series Cameras

1@ Starts to download images " ’

Lets you select and download images

™

P
{t

¥
I

Camera settings/Remote shooting

&

For cameras supplied with the cable
protector, attach the cable protector to the
camera, and then follow the procedure
below to connect the dedicated cable.
Make sure the < <= > mark on the plug is
facing the top of the camera and then
connect the plug to the camera’s

< DIGITAL> terminal.

Montor folder and import images

Monitor Folder ( )

@

Remote Shooting

The above window shows information displayable when EOS-1D Mark Il N is
connected. The displayed information varies depending on the camera model
connected.

Set the camera’s power switch to <ON>. .
Troubleshooting

Communication between the camera and J’J NN ® If [EOS Utility] does not start up even after performing step 4, double-click the [EOS
your computer starts. The dialog box in ° N\ \\ Utility] icon on your computer’s desktop, or click the [Start] button B> select [All Programs]
]
B

step 4 is displayed. ([Programs] in Windows 2000) P> [Canon Utilities] > [EOS Utility] » [EOS Utility].

For Windows 2000, a dialog box such as " — & @
[Found New Hardware] may appear. %\ Index

- Q00O



Precautions When Connecting the Camera and Computer

@ You cannot communicate with the camera when you are displaying images through
the camera’s LCD monitor. Always connect the camera and your computer after
turning off the display in the LCD monitor.

While the camera and your computer are communicating, the camera’s LCD panel

may blink.

Use only the dedicated cable.

With EOS-1D series cameras, if you connect the plug of the dedicated cable into the

computer’s IEEE1394 port in the reverse direction, the camera or the computer may

break down. Confirm that the shape of the plug and the shape of the IEEE1394 port

match before connecting.

With EOS-1D series cameras, you cannot communicate with EOS Utility even if you

connect the USB interface cable supplied with the camera.

Push the plug firmly all the way into the socket. Loose connections can cause faults

or malfunctions.

Do not connect the camera to your computer via a hub. If you do so, the camera may

not operate correctly.

If you connect multiple USB or IEEE1394 devices (excluding mouse and keyboard) to

your computer, the camera may not operate correctly. Disconnect from your computer

any USB devices and IEEE1394 connection devices other than the camera.

Operation of the Auto power off function will automatically switch the camera off,

disabling to communicate with your computer. Set the Auto power off function to

[OFF] in advance. For more details, refer to the camera’s Instruction Manual supplied

with the camera.

Do not connect more than one camera to the same computer. The connections may

not operate correctly.

The camera cannot communicate correctly with multiple softwares. Use one software

to communicate with the camera.

When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull

it out.

* If you are using the EOS D60 or EOS D30, pull the plug while pressing the <PUSH>
button on it.

If you do not perform any operation while the camera and computer are connected, a

confirmation message may appear on the computer screen asking whether you wish

to continue communicating with the camera for some computer systems. If you do not

perform any operation even after this message appears, the communication with the

camera is terminated. To re-establish the communication, press the shutter button

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

Do not put your computer to sleep while it is connected to the camera.

If your computer goes into the sleep mode, never disconnect the dedicated cable while

your computer is still in the sleep mode. Always wake your computer up while it is

connected to the camera. On some types of computer, disconnecting the dedicated

cable while your computer is in sleep mode could prevent the computer from waking

up correctly. Refer to the computer User’s Manual for more information on sleep mode.

il

Cover/Table of
When you connect the camera and your computer, it is recommended that you use
the AC Adapter Kit (optional) for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS Contents
DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, EOS L ’
DIGITAL REBEL/300D DIGITAL, the DC Coupler supplied with the camera for the
EOS D60 and EOS D30, and the DC Coupler Kit supplied with the camera for EOS-
1D series cameras. Introduction
When connecting the EOS-1D series camera and a computer with a 4-pin type
IEEE1394 port, use the EOS-1D series dedicated Canon interface cable (optional) 4- L ’
pin/4-pin type for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark I, and a
4-pin/6-pin type for the EOS-1Ds and EOS-1D.
When using the dedicated cable supplied with the EOS-1Ds or EOS-1D, either plug
(6-pin type) can be connected to the computer or your camera.
When connecting the dedicated cable to the EOS D60 or EOS D30, insert it with the
<P> mark on the plug matched with the <P»> mark on the < DIGITAL > terminal.
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Downloading Images from Your Camera

Downloading All the Images in a Single Operation

You can download to your computer all the images saved on a memory card in the camera, in a
single operation. You can follow this same procedure when downloading images using a third-
party card reader (p.1-9).

Click the [Starts to download images] button.

The [Save File] dialog box appears and
the images are downloaded to the
computer.

The downloaded images are sorted in
folders by shot date, and are saved in the
[My Pictures] folder on the computer.
When all the images have been
downloaded, the ZoomBrowser EX starts
up and the downloaded images are
displayed. For further instructions, refer to
the ZoomBrowser EX Instruction Manual. @J B ST D S
To exit EOS Ultility, click the [Quit] button.
When disconnecting the interface cable
from the camera and computer, be sure to
exit EOS Utility and then set the camera’s
power switch to <OFF> before
disconnecting the cable.

€ £S5 Utility - Canon EOS XXX 3

Downloads using camera

Press the camera’s button

R

2
i

Starts to download images

f Lets you select and download images
=

i,

Set up camera/Shoot remotely

Moritor folder and impart images

Monitor Folder

The above window shows information
displayable when EOS 30D or EOS DIGITAL
REBEL XTi/400D DIGITAL is connected. The
displayed information varies depending on
the camera model connected.

Preferences. .

® In the preferences, only images downloaded for the first time are downloaded and saved
in the [My Pictures] folder (you cannot download images previously downloaded). You
can change the image download type or the save destination in the dialog box (p.4-4)
that appears when you click the [Preferences] button.

You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.4-5). However, if you have
downloaded images following “Downloading Images Using Your Card Reader” (p.1-9),
the software that can start up is limited to ZoomBrowser EX.

Downloading Images to Your Computer by Operating the Camera

With cameras that have the direct image transfer function, you can download to your computer
images saved in your camera’s memory card by operating the camera. For detailed instructions
on the direct image transfer function, refer to the camera’s Instruction Manual supplied with
your camera.
This function is compatible with the EOS 30D and EOS DIGITAL REBEL XTi/400D
DIGITAL.

' Cover/Table of |
Contents

Introduction

Connect the camera and the computer and then start EOS Utility
(p.1-3).

Perform direct image transfer on the camera.

The images from the camera are saved to the computer.

When all the images have been downloaded, ZoomBrowser EX starts up and the
downloaded images are displayed. For further instructions, refer to the ZoomBrowser
EX Instruction Manual.

ﬁl You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.4-5).

Downlo glmages

mera

from the

s 2!

Setting the Cameras
otherthanthe EOS-1D
Series Cameras

Setting the EOS-1D
Series Cameras

Remote Shooting

Troubleshooting

Index

- QOO



You can select the folder of the Cove r/Table Of

H image displayed in the window. You can select the size of the displayed image.
Down Ioad In g SeIGCted Im ages You can select images You can show/hide the image frame. Contents
by condition. . ) . . . .
You can display the images saved on a memory card in the camera, select the images you D);Wmoads the You can show/hide the image information display area.
want and download them to your computer. You can follow this same procedure when images to Starts the ZoomBrowser EX. r N
downloading images using a third-party card reader (p.1-9). computer. Deletes the image. ,
IL_-III| £ o Introduction
ile(F)  EditE) WiemC]) Windowlid  He |{H
Click the [Lets you select and download images] button. Dourios nages | = [0 9] [ © R @ ® 8 &——————1 The display switches to .
. . T the camera settings
The image download window appears and _ window (p.2-2, p.3-2).
the images on the memory card are D X -ﬂ % — Displays the histogram
displayed. x o (gri_gmngs?hdist;tr_ibﬁttion). Downlo glmages
n Press the camera’s butten IMG D002.JPG: MG 0003.JPG IMG 0004.JPG Ejlsnglay? Iasn d ?R g%] Ig?ﬁ: from the mera
L_ = = B RGB display.
_ IMG_0002.JPG
Downloads using camputer % A . m:}/xém
R ] (200000
ﬁ@} Starts to download images o ZBN f;fff; —_ Display; basic shooting ( )
IMG 0006 GRZ MG D007.CR2 Bl monwSu information. Sett"’]g the Cameras
=i | Lets you select and download images ] = [= & —
== : ’ = Fiztziillmage ]mnrmatmi‘ . Image information Other than the EOS'1 D
T —— F h T display area Series Cameras
amer o etiaz (oot Ehos Gua R A N ~ “gg‘s‘"?{éﬂf”‘me ] L J
Ej & G ooacr2 B 1wGomocRz B ooi.cRe B mvGooi2cR2 TV%m"ﬁ éée};é ’;:‘“_ L Displays detailed
e ———— fragre e | shooting information. ( )
B e - — Setting the EOS-1D
LI@‘ Monitor Folder elects image 1 of 21 e Ing e -
_aill Displayed on RAW+JPEG images. Displayed on images that are protected. Series Cameras
Displayed on RAW images.
The above window shows information “» Click the [Download Images] button.
displayable when EOS 30D or EOS DIGITAL ) . . - N
REBEL XTi/400D DIGITAL is connected. The The [Download image] dialog box appears.

displayed information varies depending on

h del d. R
the camera model e Specify the save destination and then click the [OK] button. Remote Shooting

4" = The [Save File] dialog box appears and the images are saved in the specified folder.
Click the target image. .

o ) ) When all the images have been downloaded, the ZoomBrowser EX starts up and the
To select multiple images, hold down the <Ctrl> key and click the images. downloaded images are displayed. For further instructions, refer to the ZoomBrowser
To select sequential images, click the first image and then hold down the <Shift> key EX Instruction Manual.
and click the last image. When switching to the main window, select the [Window] menu » [Main Window].
To exit EOS Ultility, click the [File] menu P> [Exit]. L
When disconnecting the interface cable from the camera and computer, be sure to - ~
exit EOS Utility and then set the camera’s power switch to <OFF> before I d
disconnecting the cable. naex

Select the images to download.

Troubleshooting

ﬁl [F]]is displayed on images previously downloaded to your computer. L .
[ &3] is displayed on images shot with AEB.
With the EOS-1D series cameras, a [| | ] is displayed on images with sound recorded.
You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.4-5). However, if you have
downloaded images following “Downloading Images Using Your Card Reader”

(p.1-9), the software that can start up is limited to ZoomBrowser EX.
1-7 @ @ @



Downloading JPEG Images Using the PTP Function

Downloading for Cameras other than the EOS-1D Series Cameras

Downloading method for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL

REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL and EOS DIGITAL

REBEL/300D DIGITAL

When using Windows XP, you can use the PTP (Picture Transfer Protocol) function. When you

set the camera’s [Communication] and use the PTP function, you can download to your

computer JPEG images saved in your camera’s memory card without having to use EOS Utility.
This function is compatible with the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS
DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL and EOS
DIGITAL REBEL/300D DIGITAL.

Check that the camera and the computer are not connected and
then set the camera’s power switch to <ON>.
With the EOS DIGITAL REBEL XTi/400D DIGITAL, steps 1 to 3 are not necessary.
Continue with step 4.

Set the camera’s [Communication].
Set the [Communication] for cameras in the same procedure as the “Setting a
Camera with [Communication] Settings” (p.1-2), using the following for a reference.

[Communication] settings for different cameras

Camera model Menu Setting
EOS 5D [¥T Communication] [Print/PTP]
EOS 30D [¥T Communication] [Print/PC]
EOS 20D [¥T Communication] [PTP]
EOS 10D [Communication] [PTP]
EOS DIGITAL REBEL XT/350D DIGITAL [¥T2 Communication] [Print/PTP]
EOS DIGITAL REBEL/300D DIGITAL [¥T2 Communication] [PTP]

Press the <MENU> button to switch the LCD monitor display off
and then set the camera’s power switch to <OFF>.

Connect the camera to the computer and set the camera’s power
switch to <ON> (p.1-3).

The window for selecting the software to use for downloading the images is displayed.
Select [Microsoft Scanner and Camera Wizard] and click the [OK]

button.
The [Scanner and Camera Wizard] dialog box appears.

Download images as directed in the [Scanner and Camera Wizard]
dialog box.

@ For PTP function restrictions, refer to the “Precautions for the PTP Function” (p.1-9).

Downloading with EOS-1D Series Cameras

Downloading method for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark I
When using Windows XP, you can use the PTP (Picture Transfer Protocol) function by

connecting the supplied USB interface cable to the camera’s direct print terminal. By using the

PTP function, you can download to your computer JPEG images saved in your camera’s
memory card without having to use EOS Utility.

This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D

Mark Il.

Plug the dedicated cable into the computer.

Plug the cable into the USB port.
Refer to the computer User’s Manual for
information on the terminal areas.

"% Plug the dedicated cable into your camera.

Face the plug’s <+ > mark towards the

bottom of the camera and then connect
the plug to the camera’s direct print
terminal.

Set the camera’s power switch to <ON>.

The window for selecting the software to use for downloading the images is
displayed.

Select [Microsoft Scanner and Camera Wizard] and click the [OK]

button.

The [Scanner and Camera Wizard] dialog box appears.

Download images as directed in the [Scanner and Camera Wizard]

dialog box.

® For PTP function restrictions, refer to the “Precautions for the PTP Function” (p.1-9).

1-8
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Select [View/Download Images using Canon CameraWindow] and Cover/Table of

Precautions for the PTP Function then click the [OK] button. Contents
CameraWindow MC (Image downloading Removable Disk (G:) X L ’
@ Due to Windows XP specifications, you may experience the following restrictions with software for card readers) starts up. r N
the PTP function. We recommend downloading shot images using EOS Utility (p.1-6). b oo s s o e ey e .
* RAW images cannot be downloaded. 5 Petuss IntrOd UCt|On
(Even if RAW images are displayed, they cannot be downloaded.) What oy vantWindons o 07
+ When a memory card in the camera contains both RAW images and JPEG images, ';J o e e -

you may not be able to download the JPEG images.

» Shooting information for downloaded images may be altered or deleted.

» Images cannot be downloaded if there is a large quantity of images in the camera
(approximately 1,000 images).

L o
gy Pinttepicres

Downlo glmages

from the @amera

* It may take several minutes after connecting the camera and your computer until B g Zoomromser Ex
the PTP function is operational. ', Oipen falder to view files v
* Vertically shot images become horizontal when downloaded, or an image does not [l always do the selecled oo ( )
rotate even if you use the Rotate command. [ ok ]) cancel | Setting the Cameras
In addition to the above restrictions, you may not be able to download images otherthanthe EOS-1D
co_rrectly dependlng c?n your OS version and computer enwrorTment. Click the [Starts to download images] button or [Lets you select Series Cameras
\éVlth.the EOS 10!3, it is necessary t(? changg the firmware version to 2.0.0 or later. For and download images] button. L )
etails on changing, refer to Canon’s web site.
When using the PTP function with the EOS-1D series cameras, connect with the USB To continue, you can download images ( )
interface cable supplied with the camera. using the same procedure as in Bouie mages | P Setting the EOS-1D

“Downloading All the Images in a Single
Operation” (p.1-6) and “Downloading -

Downloading Images Using Your Card Reader N S B oot ‘ ‘

You can also download images to the computer using a third-party card reader. ggﬁl Lets you select and download images

Series Cameras

Remote Shooting
Load the card into the card reader.

The dialog box in step 2 appears.
If the dialog box in step 2 does not appear, |
click the [Start] button P> select [All TrOU bleShOOting
Programs] ([Programs] in Windows 2000)
P [Canon Utilities] » [CameraWindow] ® Depending on the card reader you are using, you may not be able to download " <
[CameraWindowMC] B [CameraWindow]. images. .

When downloading images using your card reader, the software that can start up is

limited to ZoomBrowser EX. |ndeX

ﬁl For information on connecting the card reader to your computer, refer to the card

reader User’s Manual.

When downloading images to your computer using a third-party card reader without
using Canon software such as EOS Utility or CameraWindow, refer to “Folder
Structure and File Names” (p.5-4) and copy to your computer the folder with the shot

l boe



Transferring the Images in a Specified Folder

By inserting images in a transfer origin folder, the images can be transferred to the transfer Click the [ L

' Cover/Table of |

destination folder and displayed in Digital Photo Professional or ZoomBrowser EX. o ContentS
In addition, when using the EOS dedicated Wireless Transmitter WFT-E1/E1A (optional), by Image transfer preparation is complete. L
specifying the folder where the shot images will be saved, you can check the shot images in . B ..
Digital Photo Professional or ZoomBrowser EX in real time. Insert images in the transfer origin folder. , N
Images are transferred to the transfer destination folder, and ZoomBrowser EX starts IntrOd UCtion
Click the [Monitor Folder] button. up.
The [Monitor Folder] dialog box appears. 7 EOS Utility - Canon FOS X00¢ 3] @ You cannot make the transfer origin folder and the transfer destination folder the same

Downloads using camera folder.

Downlo glmages

Press the camera’s button

B

ﬁl You can change the software that starts up when images are transferred, from from the €amera
ZoomBrowser EX to Digital Photo Professional (p.4-5).

Downloads using computer

Starts to download images

~

il

Lets you select and dawnload images Setting the Cameras
—— otherthanthe EOS-1D
RIS — ’
=] ———— Series Cameras
Monitor Folder

Setting the EOS-1D
Series Cameras
The above window shows information L J

displayable when EOS 30D or EOS DIGITAL
REBEL XTi/400D DIGITAL is connected. The
displayed information varies depending on
the camera model connected.

Set the transfer origin folder and the transfer destination folder. Remote Shooting

Monitoring of the folder specified L
as the transfer origin is cancelled.

T — ' )
[ Retumn tn main window == Close the [Monitor Folder] TI'OU b|eShOOtIng

dialog box to return to the

Monitoring of the folder ——
specified as the main window
transfer origin begins. . >

When using the WFT-E1 wireless file transmitter for EOS cameras, you
can instantly check photos you have shot in the linked software by
specifying the destination Folder For those photos as the Monitored
Folder.

IMonitored Folder
i~ Click the [Browse] button IndeX
[tonitor all subfolders [Corowse. | and in the dialog box that
(oo ] appears, select the L J
Destination Folder transfer origin folder.
(1 C:\Documents and Settings'Photo — Click the [Change] button

and in the dialog box that
appears, select the
transfer destination folder.

w QOO



2 Setting the Cameras other than the EOS-1D Series Cameras

This chapter explains the functions that can be set in the EOS 5D, EOS 30D,
EOS 20D, EOS 10D, EOS DIGITAL REBEL XTi/400D DIGITAL, EOS
DIGITAL REBEL XT/350D DIGITAL, EOS DIGITAL REBEL/300D DIGITAL,
EOS D60 and EOS D30.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-3).

© Click on the item to display its page.

Basic SettingS......cccivminiiniii i —————— 2-2
Shot Settings .....cccevriiiirri e —————————— 2-3
PiICUrE SEYIE ..o 2-3
White Balance Adjustment......... .o 2-5
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Basic Settings

You can perform settings on the camera, such as setting the camera owner’s name and setting Click the item to be set and specify the settings. Cover/Table of
the date and time.
The settings are applied to the camera. Contents
Click the [Camera settings/Remote shooting] button. You can show/hide the shot b )
Th ti ind settings window (p.2-3).
€ Camera setlings window appears. % EOS Utility - Canon EOS 33X 3 The dis . . . 2
= play switches to the You can show/hide the basic
Downloads wsing camera image download window (p.1-7). settings window. IntrOd UCtIOn
Downloads using compter You can enter up to 31 .
fg . v h , characters and register the Downloadlng Images
B state 1o dommiond s dgtlé%a:ﬂistﬁtqte.e camera’s camera owner's name. from the Camera
B Lot you setct an downioad imaes You can initialize the
S . memory card in the camera. \
The camera’s firmware i ; Wer. 1.0.0
—_— version is displayed, and
@l c (tings/Fmote shoofing you can perform updates. Setti
T AR etting ameras
other thangite EOS-1D
- Displays the various ———— | | %— Closes the window. i
Monitor Folder camera information. o g Series L
Returns to the previous window.
_— Preferences... | __le - ~
When switching to the main window, select the [Window] menu P> [Main Window].
The above window shows information ; ; i ; i -
displayable when EOS 30D or EOS DIGITAL ® If you select the [File] menu P> [Exit], EOS Utility exits. Set’flng the EOS-1D
(I;\{EIS‘IEL )éTi/?OODPIGITA]- isgonnegted. The ® The above window shows information displayable when the EOS 30D or EOS Series Cameras
Theraera ool corraciaaliad 0" DIGITAL REBEL XTi/400D DIGITAL is connected. The displayed information varies |
i . depending on the camera model connected.
Click [| %1 )]. ) ,
The basic settings window appears. —— @ Initializing 2 memory card deletes all the data and the data cannot be recovered. Check
N B ) canon 05 300X [-]5|K] carefully before initializin Remote Shooti
Click again to close the basic settings T —T— ———— ULy g. €mote shooting
window. ——
- L
P
150 - S
100 :
00 Troubleshooting
€3] L
"2..'1..?..“1..“2 r )
You can shoot photos remotely. For remote =—
shooting, refer to Chapter 4. P G) @ - IndeX
5 L
] ONESHOT @
#§ 1999 | \&=
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Shot Settings

You can apply various shot settings to the camera.

Click the [Camera settings/Remote shooting] button.

~» The camera settings wiindow appears.

Click [(@a .

=» The shot settings window appears.
© Click again to close the shot settings window.

Select the item to be set and specify the settings (p.2-3 to p.2-5).

-» The settings are applied to the camera.

You can show/hide the shot
settings window.

The display switches to the

| € You can show/hide the basic
image download window (p.1-7).

settings window (p.2-2).

L

e
= )

Picture : Standard

WE SHIFT 00

Displays the various
camera information.

i ] | [ Closes the window.

Returns to the previous window.

® When switching to the main window, select the [Window] menu P> [Main Window].

® If you select the [File] menu P> [Exit], EOS Ultility exits.

@ The above window shows information displayable when the EOS 30D or EOS
DIGITAL REBEL XTi/400D DIGITAL is connected. The displayed information varies
depending on the camera model connected.

Picture Style

You can select a Picture Style and set it to the camera, or register a Picture Style file,

downloaded from Canon’s web site and saved on your computer, as a user setting in the

camera.

© This function is compatible with the EOS 5D, EOS 30D and EOS DIGITAL REBEL XTi/
400D DIGITAL.

Selecting a Picture Style

Click [Picture Style].

=» The [Picture Style] window appears.

Click the Picture Style to be set in the camera.

-» The settings are applied to the camera, -
and the display returns to the shot settings ( = m )
window. Fictu

Portrait

' Cover/Table of |
Contents

Introduction

Downloading Images
from the Camera

ameras
e EOS-1D

Setting
othertha

Series ras

Setting the EOS-1D
Series Cameras

Remote Shooting

Troubleshooting

Index

- QOO



Detailed Settings © You can register up to 3 user settings in your camera. Cover/Table of
© When you select [Monochrome] in the [Picture Style] list box, the [Filter effect] and Contents
[Toning effect] list boxes appear.

© Refer to “Registering the Picture Style” in the camera’s Instruction Manual for
information about using the Picture Style registered in the camera.

Click the [Apply] button. Introduction

=» The [Confirm settings] dialog box appears.

Click [Picture Style].

=» The [Picture Style] window appears.

Confirm the settings and click the [OK] button.

Click [Settings]. - The settings are registered in the camera. ngqﬁea(ggrgnggges
=» The [Picture Style setting] dialog box ~ .
appears. Lo KD Click the [Close] button. L

=» The [Picture Style setting] dialog box closes.

. . Setting ameras
Select the specified user setting. other thandhie EOS-1D
© Following the “Selecting a Picture Style” procedure (p.2-3), select the specified Series ras
Picture Style.
-» The settings are applied to the camera, and the display returns to the shot settings
window.

Setting the EOS-1D
Specify desired settings. ﬁl A Picture Style file is a file that expands the Picture Style function. For detailed Series Cameras
information on Picture Style file, refer to the Canon’s web site.

Picture Style setting

FEr=sla: | Standzrd _~+—— Select the Picture Style to be set.
) Remote Shooting
=— If you have selected [User Defined1] to [User
=l Defined3] in the [Picture Style] list box, you can
J click the [Open] button and load a Picture Style L
) file saved on your computer. You can also
o123 45 6 7 select from the list box the Picture Style that will ( )
o oy become the base style.
ISTPRSEs | J .
$ a2 0 Troubleshooting
Contrast : : : \ S L
—— Drag the slider for each item left or right to set.
4 32 4 0 +1+2 43 +4 -
S aturation :
1]
432 10 142 43 44 IndeX
Calor tare : j

Cloge |

|
1
Cancels all the settings and closes the dialog box.

Deletes the selected Picture Style from the camera.
Applies the settings to the camera.
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. . ' Cover/Table of |
White Balance Adjustment Contents
You can compensate the white balance and apply it to the camera.

© This function is compatible with the EOS 5D, EOS 30D, EOS 20D, EOS DIGITAL 1 )
REBEL XTi/400D DIGITAL and EOS DIGITAL REBEL XT/350D DIGITAL. q
Introduction

1 Click [WB SHIFT]. L

=» The white balance adjustment window ) — ( )
appears. d

Downloading Images
from the Camera

2 Click the compensation position. Setting ameras
- The settings are applied to the camera. other thangite EOS-1D

Series ras

Compensates green.

_ Setting the EOS-1D
CDA?\E;JaeynSSQi%n value. Series Cameras

Compensates blue. Compensates amber. .

Compensates magenta.

Remote Shooting

(1] [e] [x]
3 Click [[5]].
=» The display returns to the shot settings window. .
© To revert the corrected values to the original values, follow the procedure in step 2. Trou bleShOOtIng
Index
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3 Setting the EOS-1D Series Cameras

This chapter explains the functions that can be set in the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds and EOS-1D.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-4).

© Click on the item to display its page.

Basic SettingS......cccivminiiniii i —————— 3-2
Shot Settings .....cccevriiiirri e —————————— 3-3
PiICUrE SEYIE ..o 3-3
Specifying the Personal White Balance............ccoccoveiieeiiiie e 3-5
Specifying the JPEG Quality ........ccccoviieiiiiiiiiieicee e 3-6
White Balance Adjustment..........cc.ooiiiiiiiiiiiiiie e 3-6
Specifying the Parameters..........oooiiiiiiiiieiiee e 3-7
Specifying the Color MatriX .........coeiuiiiiiieiiee e 3-8
Personal Function Settings ..........ccccviiiiiiiinnniine s 3-8
Description of Personal FUNCHONS ........c.c.coiiiiiiiiiiiieee e 3-9
Checking Personal Function Settings .......ccccoooveeiiiiiie e 3-14
Saving and Loading Personal Function Settings ............ccccoviieviieeiiiennn. 3-15
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Basic Settings

You can perform settings on the camera, such as setting the camera owner’s name and setting
the date and time.

Click the [Camera settings/Remote shooting] button.

The camera settings window appears. ) E0s Uity - FOS 300X X

Downloads using computer

Starts to download images

Lets you select and download images

&) %

Camera settings/Remate shooting

Moritor folder and impart images

Llﬁ Monitor Folder

The above window shows information
displayable when EOS-1D Mark II N is
connected. The displayed information varies
depending on the camera model connected.

Click [| #1 )]

The basic settings window appears. o T —
» ¢ Lbanon

File  Tool Window

FoX

Click again to close the basic settings
window.

AW 00
E3) = |
21 @ 002y

s G) @ P

)
] ONE SHOT

K :999|®

\ J

You can shoot photos remotely. For remote =——
shooting, refer to Chapter 4.

Select the item to be set and specify the settings.

The settings are applied to the camera.

You can show/hide the shot
settings window (p.3-3).

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window.

| : |
(=) (a#)

You can enter up to 31

characters and register the
You can set the camera’s camera owner’'s name.
date and time.
You can set the Personal

Function (p.3-8).

Displays the various ————(#) | [%¢— Closes the window.

camera information.
Returns to the previous window.

When switching to the main window, select the [Window] menu P> [Main Window].
@ If you select the [File] menu P> [Exit], EOS Utility exits.
® The above window shows information displayable when the EOS-1D Mark Il N is
connected. The displayed information varies depending on the camera model
connected.

@ With the EOS-1Ds and EOS-1D, the [Format] item is displayed and you can initialize the
memory card. Initializing a memory card deletes all the data and the data cannot be
recovered. Check carefully before initializing.
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Shot Settings

You can apply various shot settings to the camera.

Click the [Camera settings/Remote shooting] button.

=» The camera settings window appears.

Click [(@a .

=» The shot settings window appears.
© Click again to close the shot settings window.

Select the item to be set and specify the settings (p.3-3 to p.3-8).

-» The settings are applied to the camera.

You can show/hide the shot
settings window.

The display switches to the
image download window (p.1-7).

You can show/hide the basic
settings window (p.3-2).

|
(C Ilﬁ‘ )

Picture Standard

& balance
JPEG Gluality
HIFT

Displays the various
camera information.

i ] | [ Closes the window.

Returns to the previous window.

® When switching to the main window, select the [Window] menu P> [Main Window].

® If you select the [File] menu P> [Exit], EOS Ultility exits.

@ The above window shows information displayable when the EOS-1D Mark Il N is

connected. The displayed information varies depending on the camera model
connected.

Picture Style

You can select a Picture Style and set it to the camera, or register a Picture Style file,
downloaded from Canon’s web site and saved on your computer, as a user setting in the
camera.

© This function is compatible with the EOS-1D Mark Il N.

Selecting a Picture Style

Click [Picture Style].

=» The [Picture Style] window appears.

Click the Picture Style to be set in the camera.

=» The settings are applied to the camera, . —
and the display returns to the shot settings ( = m )
window. Fictu

Portrait
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Detailed Settings © You can register up to 3 user settings in your camera. Cover/Table of
© When you select [Monochrome] in the [Picture Style] list box, the [Filter effect] and Contents
[Toning effect] list boxes appear. L

Click [Picture Style].

=» The [Picture Style] window appears.

© Refer to “Registering the Picture Style” in the camera’s Instruction Manual for
information about using the Picture Style registered in the camera.

Click the [Apply] button. Introduction

=» The [Confirm settings] dialog box appears. E

Confirm the settings and click the [OK] button.

Downloading Images
=» The settings are registered in the camera. 9 9

from the Camera

Click [Settings]. Click the [Close] button. L
=» The [Picture Style setting] dialog box @ m N -» The [Picture Style setting] dialog box closes. > >
appears. g ' . . Setting the Cameras
Select the specified user setting. otherthan the EOS-1D
© Following the “Selecting a Picture Style” procedure (p.3-3), select the specified Series Cameras
Picture Style. .
-» The settings are applied to the camera, and the display returns to the shot settings

window.

Setting t 0S-1D

ﬁl A Picture Style file is a file that expands the Picture Style function. For detailed Series Cameras
information on Picture Style file, refer to the Canon’s web site.

Specify desired settings.

Picture Style setting

Remote Shooting

e Hl: [standard ~I—— Select the Picture Style to be set.

—— If you have selected [User Defined1] to [User

=l Defined3] in the [Picture Style] list box, you can
QA click the [Open] button and load a Picture Style

file saved on your computer. You can also TI’OU b|eShOOtIn
o1z 3 4 5 68 7 select from the list box the Picture Style that will g
oy become the base style. L
Sharpress : |
403 -2 10 41 +2 43+ - ~
Contrast :
onias B —— Drag the slider for each item left or right to set. I ndeX
403 2 0+ 42 43+
Saturation : j L
4 32 4 0 +1+2 43 +4
Calor tane : j
s d—1— Cancels all the settings and closes the dialog box.

1
Deletes the selected Picture Style from the camera.
Applies the settings to the camera. @ @ @
3-4




Specifying the Personal White Balance

Up to 3 white balance files saved with RAW Image Task can be registered in the camera as
personal white balance.
These functions are compatible with all EOS-1D series cameras.
For how to save a white balance file with RAW Image Task, refer to “Processing RAW
Images” in the ZoomBrowser EX Instruction Manual.
When you register a personal white balance file to the camera, < P - { >to< P -3 >is
displayed on the rear LCD display panel of the camera.
For more information on setting the personal white balance on the camera, refer to
“Selecting the White Balance” in the camera’s Instruction Manual.

Click [Personal white balance].

The [Personal white balance settings] -
dialog box appears. (E

€3 )

Select the personal white balance to be registered.

Perzonal white balance zettingz

Personal white balance 1[(PC-1] : Mot set
Perzonal white balance 2[PC-2) : Mot zet
Perzonal white balance 3[FC-3) : Mot zet

|< 3

Click the [Open] button.
The [Open] dialog box appears.

Personal white balance settings §|

Personal white balance settings

lhi - ) )
Personal whits balance 3[PC-3) - Mot set —— Displays the setting status for the
personal white balance registered
on the camera along with their

Personal white balance setting name: H titles.

cames | [f Close -7 Closes the dialog box.

Deletes the selected personal white balance from the camera.

Registers the selected personal white balance settings on the camera.

Enter a title for the personal white balance to be registered.

Open the folder containing the saved white balance file, select the
4 file, and then click the [Open] button.

» The white balance file is loaded.
[ Enter a title in the [Title] input box.
"4
Click the [Apply to camera] button.

=» The personal white balance file is registered on the camera.

To register another setting, repeat steps 2 to 6. You can register up to 3 settings
(PC-1, PC-2 and PC-3).

Click the [Close] button.

The [Personal white balance settings] dialog box closes, and the display returns to
the shot settings window.
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Cover/Table of
Specifying the JPEG Quality White Balance Adjustment Contents
You can specify the JPEG quality and register the settings on the camera. You can compensate the white balance and apply it to the camera. h
© This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D © This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D 1 )
Mark Il. Mark Il. .
Introduction
Click [JPEG Quality]. 1 Click [WB SHIFT]. 1
=» The [JPEG Quality] window appears. - -» The white balance adjustment window ( )
(=) ‘:I 1)
appears. Downloading Images
from the Camera
Setting the Cameras
. . . . . - otherthanthe EOS-1D
Click the setting position. 2 Click the compensation position. Series Cameras
~» The settings are applied to the camera. (E m ﬂ-'\_ =» The settings are applied to the camera. L

© Higher values give a lower compression
ratio and higher image quality for any size.

Setting t 0S-1D

Series Catieras
Compensates green.

Displays the
compensation value.

Compensates blue. Compensates amber.

Remote Shooting

Compensates magenta.

Click [[25]].

=» The display returns to the shot settings window.

3 Click [[5]]. Troubleshooting

=» The display returns to the shot settings window. L
© To revert the corrected values to the original values, follow the procedure in step 2.

Index
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e . Specify desired settings. Cover/Table of
Specifying the Parameters _ Contents
Parameters settings [g‘
You can upload sharpness and contrast settings as well as a tone curve file saved with RAW —
. . ) Setl [setz || set3
Image Task and register up to 3 of these in the camera as processing parameters. ( )
© This function is compatible with the EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1Ds and Tone Curve: q
EOS-1D. o [Standard]: Introduction
© For how to save a tone curve file with RAW Image Task, refer to “Processing RAW Images” O.Llser I The standard tone curve is set.
in the ZoomBrowser EX Instruction Manual. TCD1
© For more information on setting the processing parameters on the camera, refer to “Setting ) ) ( )
the Processing Parameters” in the camera’s Instruction Manual. [Tuégglpef'”ed TCD1]to [User Defined ;
: . . Downloading Images
You can apply the tone curve file saved in
RAW Image Task. from the Camera
Click [Parameters] With the EOS-1Ds and EOS-1D, [User
) Defined] is displayed and you can select L
i i one tone curve file.
= The [Parameters settings] dialog box G Loz 3 4 s Click the [Add] button and in the dialog box
appears. i that appears, select the tone curve file ( )
Srerrresss saved on your computer. Setting the Cameras
_d otherthanthe EOS-1D
1S tandard A Series Cameras
0.0 Apply ko Camera Applies the settings to the camera.
. Setting t 0S-1D
3 cl —— Closes the dialog box. N
(i) _SIx] L 3 Series Caffieras
Select a tab to be set. Drag the slider left or right to specify the sharpness and contrast.
With the EOS-1Ds and EOS-1D, [Sharpness] and [JPEG Quality] are displayed. Select
the item to be set from the list box. - ~

Parameters settings
Click the [Apply to Camera] button. Remote Shooting
( Setil ] Set2 | Set3 >' =» The [Confirm settings] dialog box appears.
Confirm the settings and click the [OK] button.

=» The processing parameter is registered on the camera.

Troubleshooting
Click the [Close] button.
-» The [Parameters settings] dialog box closes, and the display returns to the shot .
settings window.
Index
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Specifying the Color Matrix

You can set the color matrix. You can also set in the camera up to 2 color matrix ([6CM set1]

and [7CM set2]) that have color space, color saturation and color tone set optionally.

® This function is compatible with the EOS-1Ds Mark Il and EOS-1D Mark II.

© For more information on setting the color matrix on the camera, refer to “Selecting the Color
Matrix” in the camera’s Instruction Manual.

Click [Color matrix].

=» The [Color matrix] window appears.

=)

€3 )

Click the color matrix to be set in the camera.

=» The settings are applied to the camera,
and the display returns to the shot settings
window.

© For the color space, color saturation and
color tone of [6CM set1] or [7CM set2],
click the [Settings] button and set in the
[Color matrix settings] dialog box that
appears.

® The optional settings [Color space], [Saturation] and [Color tone] in the [Color matrix
settings] dialog box can only be set when [6CM set1] or [7CM set2] is selected in the
[Color matrix] list box.

Personal Function Settings

You can set detailed settings for each function and apply them to the camera. You can also
save the specified settings on your computer and load the saved settings.
© These functions are compatible with all EOS-1D series cameras.

Click the [ ¥T )] button.

=» The basic settings window appears.

Click [Personal functions].

=» The [Personal functions] dialog box
appears.

Select a tab to be set.

Rersonal funciions

AF functions

Other functions 2 Other functions 3

Exposure funcions 1 Exposure funcions 2

|

Drive functions

Other Functions 1
Combination
Exposure functions 3

(o [F)

[C1(P Fre01) Disablas the shooting modes
[ Disable proara

|| Disable
=i

[[]tP.Fn-02) Disables the matering mades

Loads the details of the Personal

Functions that have been specified on
the camera.

[ losdsettngs | Reset

— All data set in each window is cancelled.

[ Apply to camera | [ oK ] [

Cancel

—— Cancels all the settings and closes the

dialog box.

1
Applies the settings
to the camera.

=» The selected window appears.

1
Applies the settings to the camera
and closes the dialog box.

© In the [Combination] tab sheet, you can check the specified Personal Function
settings and the status of whether or not the settings are applied to the camera. You
can also save and load the Personal Function settings (p.3-14, p.3-15).

3-8

' Cover/Table of |
Contents

Introduction

Downloading Images
from the Camera

Setting the Cameras
otherthanthe EOS-1D
Series Cameras

0S-1D
ras

Setting t

Series Ca

Remote Shooting

Troubleshooting

Index

00O



Checkmark the box [[] and specify desired settings (p.3-9 to p.3-14). Cover/Table of

Description of Personal Functions Contents

r( .Fn-01} Disables the shooting mades The shown in this section provides brief descriptions of the Custom Function Settings L .

T |Disable pragram AE for the respective camera functions. For more details, refer to “Custom Function Settings” in ( )

SHER the camera’s Instruction Manual supplied with the camera. .

[ pisable shutter-priority AE I ntr0d UCt|On

[ Disable aperture-priority SE [ZIZiXE] Disables the shooting modes . /

[ isable manual exposure Checkmark the shooting modes you do not want to use. 2 =

[ bisahle bulb exposure Unwanted shooting modes can be skipped while you are selecting the shooting mode.

Downloading Images

This makes selecting the desired shooting mode faster.
from the Camera

If you enter a numerical value, values outside the valid range of settings are ignored. With the EOS-1Ds and EOS-1D, [Disable depth-of-field AE] is also displayed.
Check the settings and save them on your computer if necessary (D At least one checkbox must be left unchecked.
(p.3-14, p.3-15). c N

Setting the Cameras
Click the [OK] button. [ZIF7] Disables the metering modes otherthanthe EOS-1D
) . Checkmark the metering modes you do not want to use. Series Cameras
The settings are applied to the camera, ) ] ) ) )
the [Personal functions] dialog box closes, ',ES [ SEJ Unwanted metering modes can be skipped while you are selecting the metering mode. " 5
i i ® This makes selecting the desired metering mode faster.
and the display returns to the basic av 55 ONE SHOT 9 9

settings window.
When a Personal Function is applied to
the camera, <ff> appears on the LCD
panel. [IFXE Specifies the metering mode for manual exposure
® Select the metering mode to be specified. r N
® You can specify the metering mode to be used in the manual exposure mode.
When you set the manual exposure mode, the metering mode selected here will be set Remote Shooting
automatically. In the manual exposure mode, this enables you to use a metering mode
different from the one used in the AE modes. { J

E@: E @ At least one checkbox must be left unchecked. Setting t 0S-1D

= 2102 RS

Series Cameras

Troubleshooting
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Cover/Table of

[ITE7] Sets the maximum and minimum shutter speeds to be used

Select the maximum and minimum shutter speeds from the list box. [ZTE Registering the Modes and Settings with the Camera Contents
For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the Set the shooting mode and shooting mode settings (for J
slowest, the shutter speed range will be 1/2000 to 1/60 sec. exampl . ..
: i ) ple, aperture setting for aperture-priority AE mode). Then
This makes shutter speed selection faster and prevents a slow-speed sync. in aperture- set the meterina mode and exposure compensation amount
priority AE mode with the flash. 9 P P ’ |nt|"od uct|on

@ Register the modes and settings.

If you set the maximum and/or minimum shutter speed to one that is not a full-stop
increment (such as 1/750 sec.), the controllable and settable shutter speed range
might not be as exact as you set it (A slight deviation may occur.). This applies if you
also set Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or
minimum shutter speed to one that is not a full-stop increment (such as 1/3200 sec.).
To ensure that a proper flash sync speed is set in the Program AE mode, a shutter
speed range of 1/200 sec. to 1/80 sec. cannot be set with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark Il and EOS-1Ds, and the range of 1/400 sec. to 1/80
sec. cannot be set with the EOS-1D.

If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter speed
range.

First press the < > button, then press
the < (13 > button.

Downloading Images
from the Camera

\ J

Setting the Cameras

otherthanthe EOS-1D
Series Cameras

< O >appears in the LCD panel,
indicating that the modes and settings
have registered.

@ The registered modes and settings can
be modified any number of times.

[ATE Sets the maximum and minimum apertures to be used

Select the maximum and minimum apertures from the list box.
For example, if you set 1.4 for the largest aperture (minimum f/number) and 8.0 for the

0S-1D
@ Series Cameras

smallest aperture (maximum f/number), the usable aperture range will be /1.4 to f/8.0. To register the modes and settings, first press the < > button before the < >
You can better control the apertures used by setting the range of usable apertures. button. If you press the < > button first, the camera will only select the
registered modes and settings instead.
® Specify a minimum aperture value that is smaller than the maximum aperture setting. Bulb cannot be preset.

I you select a minimum aperture value that is larger than the maximum aperture, a @ You cannot select the registered modes and settings during continuous shooting.
warning message appears and the setting reverts to the default value.
If you set the maximum and/or minimum aperture to one that is not a full-stop
increment (such as f/4.5), the controllable and settable aperture range might not be L
as exact as you set it (A slight deviation may occur.). This applies if you also set

Setting t

Remote Shooting

If P.Fn-03 has been set to specify the metering mode for manual exposure, and
P.Fn-06 is used to register the manual exposure mode and a metering mode

Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum
aperture to one that is not a full-stop increment (such as /6.3).

If the largest aperture of the attached lens is smaller than the largest aperture you set If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture within Trou bleShOOtmg
with P.Fn-05, the largest aperture will be set to the lens’ largest aperture. And if the the range specified with P.Fn-04 and/or P.Fn-05. |
largest aperture of the attached lens is smaller than the smallest aperture you set with If the shooting and metering modes you want to set are excluded by the

P.Fn-05, the aperture will be set and fixed to the lens’ largest aperture. restrictions in P.Fn-01 and P.Fn-02, those Personal Functions must be disabled. N
If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05's aperture range. For information on clearing and resetting Personal Functions, refer to “Clearing Index

[ITET Registers and switches the shooting mode and metering mode

Only while you press the < > button, you can switch to the preset shooting mode,
exposure setting (such as the aperture for aperture-priority AE), metering mode, and
exposure compensation amount.

Select settings that are appropriate for each shooting mode.

The modes and settings are preset with the camera.

Convenient when you want to instantly select the preset modes and settings to suit a
particular shooting situation such as backlit or front-lit conditions.

C.Fn

different from the one specified with P.Fn-03, you can select the metering mode
specified with P.Fn-03 by pressing the < > button.

and Resetting Personal Functions” in the camera’s Instruction Manual supplied
with the camera.

Even if the shooting and metering modes selected by P.Fn-06 are excluded by the
restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when you
press the < > button.
When C.Fn-18 is set, P.Fn-06 is disabled.

- QOO



Repeats bracketing during continuous shooting

While you hold down the shutter button, bracketing repeats continuously in the currently
selected drive mode.

This function is useful when you want to continuously repeat the bracketing sequence.

AF5E Sets the number of shots to be bracketed
Select the number of shots from the list box.
The usual 3-shot bracketing is changed to 2-, 3-, 5-, or 7-shot bracketing.

In bracketing shots, if you select 5-shot bracketing with 1-stop increment, the bracketing for
the shots is -2, -1, 0, +1 and +2.
This function is useful for adjusting the range of bracketing.

@ Even when the setting is outside the bracketing level display range, the exposure is
compensated as specified.
This function can be used in combination with C.Fn-09-2/3 and P.Fn-09.

[ZITE T Changes the bracketing sequence for C.Fn-09-2/3 to increased
exposure, standard exposure, and decreased exposure

The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure - standard
exposure = increased exposure) changes to increased exposure = standard exposure —>
decreased exposure.

This function is useful when you want to start the bracketing sequence with a increased
exposure.

@ This function can be used in combination with P.Fn-08.

[ITET) Retains the shift amount for program shift
Normally, any program shift amount is canceled after you take the picture. This Personal
Function retains the program shift amount.
This function is useful when you want to shift the standard program line so that priority is
given to the shutter speed or to the aperture.
By shifting the program, you can change the shutter speed or aperture and still retain the same
exposure level. Under the same brightness, you can shift the program line toward the right to
set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the program
line toward the left to set a slower shutter speed and a smaller aperture (higher f/number).
P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the level
of priority you want to give to the shutter speed or aperture setting.

Darker « Brightness (EV at ISO100) — Brighter

5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 Aperture
32

22

»
o
5

/7 '
N
2
/ 7~ 2.8
N
B J )
/ 7 ~
N
; V4
4 L * 14
N
~
= ~1 10
30 15 8 4 2 1 2 4 8 15 30 60 125 250 500 1000 2000 4000 8000

— Shutter Speed
e Standard program line
== == == Program line shifted toward a faster shutter speed.
Program line shifted toward a slower shutter speed.

With EF50mm /1.4 USM

@ The program shift amount remains in effect until you set it back to the standard program
manually or replace the battery or press the <CLEAR> button.
The shift amount is retained even after you change the lens.

[ZFi=E Executes Al Servo AF continuous shooting giving priority to
the drive speed
This function is compatible with the EOS-1D only.
During continuous shooting, shutter release-priority takes effect instead of focus-priority.

Effective when it is more important to capture an image even though it might be slightly out
of focus.
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[ZIi¥] Disables focus detection (search driving) by the lens drive
Normally, when you press the shutter button halfway and focus cannot be achieved, the lens
is driven to search the correct focus. This lens driving operation can be turned off.

When focus has been achieved once and refocusing fails, the subsequent lens driving
operation can result in grossly out of focus. This subsequent lens driving operation is turned
off. P.Fn-14 is especially suited for super telephoto lenses.

@ If autofocusing is attempted while the lens is way out of focus, the lens may stop
operating. Focus manually until the subject outline becomes discernable, then
autofocus.

[i¥H Disables the AF-assist beam from being emitted
This disables the external Speedlite’s built-in AF-assist beam.
At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the
subject from being photographed by other photographers.

[ Enables automatic shooting when focus is achieved at the
fixed point of focus while the shutter button is pressed fully

This takes the picture automatically when the subject comes to the preset focusing distance.
Focusing detection is performed using the selected AF point.
Set the lens focus mode switch to <MF> and focus manually at the desired point of focus.
Keep pressing the shutter button fully.
Using an accessory such as Remote Controller RS-80N3 which can lock the shutter button
relieves you from holding down the shutter button while you wait for the subject.

@ Because the camera remains on standby while the shutter button is fully pressed,
battery power is used up more quickly. For long periods of photography, use the DC
Coupler Kit supplied with the camera.

When this function is used in combination with a flash, the flash remains on standby
at full charge. Consequently, the flash batteries are used up more quickly. (The
Speedlite’s SE mode is disabled.)

When you use a flash with this function, set the drive mode to single shooting. If you
select continuous shooting, the flash will be unable to charge in time for successive
shots and will not fire at full charge.

If you set the drive mode to continuous shooting, set the number of shots in P.Fn-20.
If you do not use P.Fn-20, once the camera focuses on the subject, continuous
shooting will continue until the capacity of the memory card is reached.

P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow to
be used with autofocusing.

Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of
whether the image is in focus.

ﬁ Using an accessory such as Remote Controller RS-80N3 which can lock the shutter
button is recommended.

25 Disables automatic AF point selection
When you select beyond the peripheral AF point, the selection stops there. It makes
selecting a peripheral AF point faster.

If C.Fn-11-2 has been set, you can switch to automatic AF point selection by pressing
the < > button during autofocusing. For more details, refer to “Selecting the AF
Point” in the camera’s Instruction Manual supplied with the camera.

If automatic AF point selection has been preset at [AF frame registration] setting, the
preset setting remains valid. For more details, refer to “Registering and Switching the
AF Point” in the camera’s Instruction Manual supplied with the camera.

[ZXIZEE] Enables automatic AF point selection when C.Fn-11-2 has
been set
Enables the standard horizonal AF point selection together with automatic AF point
selection with C.Fn-11-2.
Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been
set.

@ If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will
override P.Fn-18 to disable automatic AF point selection.

[ZXTET] Sets the continuous shooting speed
In the list box, select the speed of continuous shots during continuous shooting.

® By reducing the maximum continuous shooting speed, Al Servo AF continuous shooting can
be more stable.
With the EOS-1Ds Mark Il and EOS-1Ds, only [Continuous Shooting] is displayed.

® In Al Servo AF, it may not be possible to complete the selected speed of continuous
shots.

[ZF@¥I] Limits the number of shots during continuous shooting
This enables you to enter the maximum number of shots to be exposed during continuous
shooting while the shutter button is pressed fully.
Convenient when you do not want to shoot an unwanted scene that follows.
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[ZIT¥71 Enables quiet operation when the shutter button is OFF after
picture-taking
When single shooting is selected, this function selects quiet camera operation when you
release the shutter button from the fully pressed position to the half way position.
This is useful when the camera operation noise would be disturbing after you take the
picture.

® If you select continuous shooting, the camera operates normally.

eflili Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

[IZ¥E] Changes the timer’s time length
After you press and release a button, the respective function remains active for a specific
number of seconds. You can change this number of seconds as necessary.
The function’s activation time can be set from 0 to 3600 sec. (1 hour).
If the standard activation time is too short or too long, you can adjust it.

AE lock time after you press the shutter button halfway or the < ¥ >

6 sec. timer button.

16 sec. timer FE lock time after you press the <FEL > button.

Exposure setting retaining time after the picture is taken. Setting
this to a longer time can make it easier to shoot in the same
exposure with AE lock.

LCD panel illumination time after the picture is taken.

Post-shutter
release timer
(2 sec. timer)

® Note that if you set a longer activation time, the battery become exhausted more quickly
and the number of possible shots will be reduced.

To turn off the function’s activation time midway, press the < MODE > button, < AF >
button or < > button.

[ZE%A llluminates the LCD panel during bulb exposures
After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the
LCD panel until the bulb exposure ends.
Convenient when you want to monitor the elapsed bulb exposure time.

@ Note that if you take bulb shots for long periods, the battery becomes exhausted more
quickly and the number of possible shots will be reduced.

[AT¥4 Sets the default settings when the <CLEAR> button is ON

You can use this function to select the default settings when you press the <CLEAR> button.

Convenient when you want to instantly switch to frequently-used settings.

[F¥11 Shortened release time lag
This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il.
Normally, the shutter-release time lag is controlled for stability. This Personal Function
eliminates this control. As a result, the shutter-release time lag can be reduced by as much

as about 20 percent when the aperture needs to be stopped down by no more than 3 stops.

This is effective when a shorter shutter-release time lag is more important than a stable
shutter-release time lag.

ﬁl Since the difference is in 10-millisecond increments, the time lag may not feel any
shorter.

Enables the electronic dial’s function to be used in the reverse
direction
© The electronic dial’s rotational function can be reversed for selecting the AF point and
setting the shutter speed and aperture.
By matching the dial’s rotation direction to the particular operation, the operation can feel
more intuitive.

® When the Main Dial’s rotational function is reversed, the horizontal AF point selection
direction does not change.

[ITF5 Prevents exposure compensation with the Quick Control Dial
@ The Quick Control Dial cannot be used to set exposure compensation.
This prevents exposure compensation from being set accidentally while the AF point is
being selected.
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[ZZIFED] Enables Quick Control Dial switch to turn on/off Main Dial, too
This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D
Mark Il
Setting the Quick Control Dial switch to <OFF> disables the Main and Quick Control Dials.

[ZIFED] Enlargement mode
This function is compatible with the EOS-1Ds only.
Select which part of an image is enlarged.
If you take the shot on the camera with this function [ON], you can enlarge an image.
For more imformation on using this function on the camera, refer to “P.Fn-30 Enlarging the
image” in the EOS-1Ds Instruction Manual.

@ If you wish to enlarge an image, set P.Fn-30 to [ON] during shooting and playback.
The image shot on the camera without setting P.Fn-30 to [ON] cannot be enlarged.
The image shot on any camera other than the EOS-1Ds cannot be enlarged.

[ZITE5 Add original decision data
This function is compatible with the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D Mark
Il and EOS-1Ds.

The data that shows whether or not the image is the original one can be added to the image.

When selecting the display format of Shooting information (INFO), the [ g ] icon showing the
captured image with Original image verification data is displayed.

For more details, refer to “Shooting Information Display” in the camera’s Instruction Manual.

To verify whether the image is the original, you will need the EOS dedicated accessory Data
Verification Kit DVK-E2 (optional).

@ For a JPEG or TIFF image converted from a RAW image and saved using Digital Photo
Professional or ZoomBrowser EX/RAW Image Task, the original decision data is not
added.

Checking Personal Function Settings

You can check the specified Personal Functions and the status of whether or not the settings
are applied to the camera.

Specify the Personal Functions (p.3-8 to p.3-14).

Select the [Combination] tab.

The [Combination] tab sheet appears.

Persanal functions.

Exposure functions 1
AF Functions
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Other Functions 2

Check the settings.

You can check the Personal Function
settings and check if these settings are
applied on the camera.

Expasure functions 1 Exposure functions 2
AF Functions Drive Functions
Other funcions 3

Other functions 2

Currert: settings ot applied to camera

PFrel1-1 Disablss the shooting modss
P Frii2-1 Disables the mel

PFr-03-1 Speciies the m
P91 Sets the mam
P Frefl5-1
F Frfie-1 Registers and switches the sh
P Fr-07-1 Repeats bracketing during cont ating
P81 Sabs the riumber of shoks to be bracketsd Shooting frame
P Frif18-1 Changes the bracketing sequence For C.Fn-08-2/3 ko ncre
PFr-10-1 Retains the shift amount for program shift

g mode for manual exposure Center-
il minimum shutter speeds ko be usec

o ] [ saens. |

1
Load settings Reset

Setting the Cameras

otherthanthe EOS-1D
Series Cameras

0S-1D
Series Cameras

Setting t

Remote Shooting

[ apmiy to camera | [ ok JI| comce ]

You can load the Personal
Function settings saved on
your computer (p.3-15).

You can save the specified Personal
Function settings (p.3-15).
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Saving and Loading Personal Function Settings Contents

You can save the specified Personal Function settings on your computer as a Personal
Function settings file and then load the saved Personal Function settings file and apply the ( )

settings to the camera. ,
Introduction

Saving the Settings on Your Computer

I 2!

Click the [Save as] button. .
Downloading Images

The [Save As] dialog box appears. from the Camera
Select the destination folder, enter the file name, and then click L )
the [Save] button. p .
The specified Personal Function settings are saved to the computer as a Personal Setting the Cameras
Function settings file. otherthanthe EOS-1D
Series Cameras
@ The Personal Function settings file is not compatible with a camera other than the one L J

the function was set.

@ If you load a Personal Function settings file saved on your computer and make Setting t 0S-1D
changes to it, you can update the loaded file by clicking the [Save] button. Series Cameras
Personal Function settings file saved in your computer is compatible with both
Windows and Macintosh.

Loading the Settings Saved on Your Computer Remote Shooting

Click the [Open] button.
The [Open] dialog box appears.

Open the folder containing the settings, select the file, and then TrOUbleShOOtmg

click the [Open] button.
The saved Personal Function settings file is loaded.

Click the [OK] button. Index

The loaded settings are applied to the
camera, the [Personal functions] dialog ,'ES [ 5.'_'"]

box closes, and the display returns to the Av E'E ONE SHOT

basic settings window. E@_ @
When a Personal Function is applied to - - 1. O 23
the camera, <> appears on the LCD = ="

panel.
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4 Remote Shooting

This chapter explains how to take shots remotely by controlling from your
computer.

For instructions on connecting your camera and computer, and for how to start EOS
Utility, refer to Chapter 1 (p.1-1).

© To perform remote shooting and camera settings for a camera with [Communication]
included as a menu function, you need to set the [Communication] according to the
following table.

[Communication] settings for different cameras

Camera model Menu Setting
® EOS 5D [¥T Communication] [PC connect.]
® EOS 30D [¥T Communication] [Print/PC]
® EOS 20D [¥T Communication] [Normal]
® EOS 10D [Communication] [Normal]

©® EOS DIGITAL REBEL XT/350D DIGITAL

[¥T2 Communication]

[PC connection]

©® EOS DIGITAL REBEL/300D DIGITAL

[¥T2 Communication]

[Normal]

For instructions on settings, refer to “Setting a Camera with [Communication] Settings”
(p.1-2).

© Click on the item to display its page.

Remote Shooting......ccccccieeiiniiiii i 4-1
SiNGIE SNOOLING ...ttt s 4-1
B4 1=T RS T T o) i3 T SR 4-2
Interval Timer ShOOtNG......ccccuuiiiiii s 4-2

Specifying the Camera Settings ......ccccvveeeiiiccceee e 4-3

Specifying Preferences........ccoiiiiiiinieiniee e 4-4
BasiC SettiNgS ...coueeieiiiieet s 4-4
Destination FOIAET.........cocvii i 4-4
FIle NAMES ... 4-4
DoWNIOad IMAGES ......oeeeiiieiiee et s 4-5
=T e o) LIS oo ] 1 o S 4-5
Linked SOftWAIE ......coiiiiiiiie e 4-5

Remote Shooting
Single Shooting

You can take a shot by remote controlling your camera from a computer.

Click the [Camera settings/Remote shooting] button.

~» The camera settings window appears.
© When switching to the main window, select Dewrinads tsing camera

the [Window] menu P> [Main Window]. ?
o

Downloads using computer

% Starts to download images
' Lets you select and download images

Camera settings/Remote shooling

Menior folder and import mages

M

The above window shows information
displayable when EOS 30D or EOS DIGITAL
REBEL XTi/400D DIGITAL is connected. The
displayed information varies depending on
the camera model connected.

7 E0S Utility - Canon EOS 33X 3

Press the camera’s button

3

I
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Specify desired settings.

& Canon EOS XXX =13

File Tool Window

Allows you to specify and —— — You can rotate and download the

check the camera settings B shot images regardless of the
(p.4-3). 150 camera position. Each time you click
i the button, the image rotates 90°.

* When using the rotation function,
checkmark [Rotate image] in the
[Remote Shooting] tab sheet of
the [Preferences] dialog box (p.4-
5).

E3] =
=2.:™..0..%..

2
(OXO, Q__

] ONESHOT

N REEE] @
(o] §1

(@

Shoot button
Click to take a shot.

The above window shows information displayable when the EOS 30D or EOS
DIGITAL REBEL XTi/400D DIGITAL is connected. The displayed information varies
depending on the camera model connected.

Click the [@] button.

The shot ime?gg is transferred to your computer and is displayed in ZoomBrowser EX.

Alternatively, you can press the camera’s shutter button to take a shot.
If you select the [File] menu P> [Exit], EOS Utility exits, including the camera settings
window.

If the camera is not ready for shooting (the lens is not attached, etc.), you cannot
perform the operation as explained.

When you are using auto focus, you cannot take shots if the camera cannot focus. In
this case, focus manually.

Bulb exposure is not available.

Alternatively, you can press the space bar to take a shot.
The transfer time to the computer of RAW images shot remotely is approximately 4 to
7 seconds.
» The above time is only an estimate. Transfer times vary widely depending on the
camera model used, the type of computer, and the subject of the photo.
« Transfer times are based on Canon testing standards.
(When using the following: OS: Windows XP, CPU: 2.2 GHz Pentium 4; RAM: 512MB)
* The transfer time to a computer of JPEG images shot remotely is less than for RAW
images.
You can change the software that starts up when you download images, from
ZoomBrowser EX to Digital Photo Professional (p.4-5).
If images shot remotely with EOS Ultility do not display in Digital Photo Professional:
From Digital Photo Professional, select the [Tools] menu P> [Sync folder with EOS
Utility].

Timer Shooting

You can automatically take a shot when the specified time elapses.

Select the [Tool] menu P [Timer shooting]

The [Timer shooting setting] dialog box appears.

Enter a delay time and click the [Start] button.

Enter a value between 0 seconds and 99 minutes 59 seconds in 1-second
increments.

The shot is taken when the specified time elapses.

Interval Timer Shooting

You can automatically take shots by setting the interval between shots and the number of shots
to be taken.
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4| Select the [Tool] menu P> [Timer shooting].

< The [Timer shooting setting] dialog box appears.

Checkmark the [Interval timer shooting].
Vs

Enter the shooting interval and the number of shots. Then click
the [Start] button.

Enter a value between 5 seconds and 99 minutes 59 seconds in 1-second
increments.

You can set the number of shots from two shots. The maximum number of shots
depends on the available space on your computer’s hard disk.

Shooting is performed at the specified interval and for the specified number of shots.

® On some types of computers, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots at
the specified interval. In this case, set a longer interval between shots and take the shots
again.
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Specifying the Camera Settings

You can check and change the settings in the camera from your computer remotely.

Check the camera setting.

Image recording quality ~ Shutter speed

Shooting mode

|
—M {EE Fis— Aperture
150
— IR {00} —1S0 Speed

) (am+4L) B

{-2..71..9..41..2|

White Balance

Save destination of shotimages
The [Preferences] dialog box is
displayed and you can set the save
destination for shot images.

Metering mode

Exposure
compensation

I— Drive mode
E ﬂ ONE SHOT—— AF mode

“ é% 33-— Shots to Go

Bracket shots

Battery status
When you are using a battery,

[ {=mw] ] is displayed. When you
are using the AC Adapter Kit
(optional) or DC Coupler Kit, [ “ ]
is displayed.

Displays the number of
possible shots.

Warning display
Displayed when the remote shooting is
impossible due to inappropriate settings.

The above window shows information displayable when the EOS 30D or EOS
DIGITAL REBEL XTi/400D DIGITAL is connected. The displayed information varies
depending on the camera model connected.

Set the functions which you cannot set remotely (drive mode, AF mode etc.) directly
in the camera.

In the [Remote Shooting] tab sheet in the [Preferences], you can save shot images to
both your computer and the memory card by setting [Save also to camera’s memory
card] (p.4-5).

Click the icon to be set. @ EEm+4L |

)

The icon displayed here shows exposure
compensation as an example.

Use the buttons to change a value.

Allows you to decrease
the value by 1 step.

Allows you to increase

® (!D G) ® the value by 1 step.
| o I

Specifies the
maximum value.

Specifies the
minimum value.

The changed settings are applied to the camera.

Settable functions and settings displays by camera model
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EOS-1D Mark II N  EOS 5D EOS 10D EOS-1D
EOS-1Ds Mark Il EOS 30D EOS DIGITAL REBEL/ EOS D60
EOS-1D Mark I EOS 20D 300D DIGITAL EOS D30
EOS-1Ds EOS DIGITAL REBEL
XTi/400D DIGITAL
EOS DIGITAL REBEL
XT/350D DIGITAL
Shooting mode © O O O
Shutter speed © © © O
Aperture © © © O
White balance (@) © © O
1SO speed © © o ? O
Metering mode © © O O
Image recording quality © © @) O
Save destination of shot images O @) © ©
Exposure compensation © @) © O
Bracket shots o O — —
Drive mode O O O O
AF mode O O O O
Battery status O O O O
Warning display O O O O
Shots to Go @) O (@) ©)

©: Allows you to display camera settings and perform camera settings
O: Allows you to display camera settings; camera settings not possible
"1 Display with EOS-1Ds not possible
"2 : Setting with EOS 10D not possible

@ Before you specify the settings, be sure to check that the camera is ready for shooting. If
the camera is not ready for shooting (the lens is not attached, etc.), you cannot make
some of the settings.

ﬁl The display for the maximum number of possible shots is the same as for the camera:
[1999] shots for the EOS-1D series cameras, [999] for all cameras other than the EOS-
1D series, and [9999] shots for the EOS DIGITAL REBEL XTi/400D DIGITAL. However, if
your computer’s hard disk capacity is large, you can shoot more images than the above
figures.
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Specifying Preferences

You can perform various EOS Utility settings.

On the main window, click the [Preferences] button, or on another
window, select the [File] menu »> [Preferences].

The [Preferences] dialog box appears.
Specify desired settings and click the [OK] button.
The settings are applied to the EOS Utility.

Basic Settings

Destination Folder

You can select the window that displays and the operation when EOS Ultility starts up.

Preferences r'z(\

Biasic settings |Destw’\atmr\ Folder | File Mames | Download Images | Remote Shooking | Linksd 4 *

Startup Action

() show main window
(O show [Lets you select and download images] screen

(O shows [Set bo Camera/Remate shooting] screen

(O Execute [Starts ko download images]

{ )

[ [ auta power off (esxcept when using an AC power supply) ]

[ ] Cancel ]

Check this checkbox to enable the Auto power off function.

Check this checkbox to start EOS Utility automatically when the camera is connected.

You can create a sub folder at the save destination for the image.
You can select the save destination for downloaded images.

Preferences El

Basic settings || Destination Folder || File Names | Download Images | Remote Shooting || Linked (< *
[

Destination Folder

‘C:\Dncuments and Settings\Photo | [ erowse...

& subfolder into which the image will be saved wil automatically be created in this Folder,
Create subfolder next time this Function is used

Download Images
[[] Remate Shooting
[ Monitor Folder

| Shating Date v| [ customize
Example:
123 CA\Documents and Settings\Phata
{21 2008_04_06
L oK ] [ Cancel

Set the sub folder division.

Select the operation when a sub folder is created.

File Names

Preferences g|

Basic settings | Destination Folder || Fils Names || Dawnioad Images | Remote Shooting | Linked € *

Do not madiry ]

Assign Sequence Mo,
Wurber of Digits ‘ |

Stark ‘ |

[ oK ] [ Cancel |

You can set the file name of downloaded images.

4-4
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Download Images

Linked Software

Basic settings | Destination Folder | File Hames |  Remote Shooting | Linked ¢ *
Settings for the [Starts to download images] button
Settings for downloaded images
[Images not et downloaded v/
[ oK ] Cancel

You can select the images to be downloaded.

Remote Shooting

Check this checkbox to also save remotely shot images to the camera’s memory card.

Preferences g\

Biasic settings | Destination Folder | File Mames | Download Images || Remote Shooking || Linked 4 *

{( [5ave slso on the camera's memory card )

: [(rotate image '

[ oK ] Cancel ]

Check this checkbox to rotate a remotely shot image regardless of the camera’s position.
Set the rotation angle in the camera settings window (p.4-2).

When downloading images from the camera or shooting remotely, you can select
the software to link and start up.

Preferences &‘

[ suttusre o
|zoomerowser Ex v e |

Settings for image downloading and direct transfer
Specify process to perform after image is downloaded.
(3) Display the Folder at the save destination

() Perform selected processss consacutively

[ oK ] [ Cancel ]

Specify the settings that are automatically performed when the linked
software starts up and downloads the images.
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Troubleshooting

This chapter provides troubleshooting and explains how to uninstall the
software.

Troubleshooting

If you could not complete the installation correctly, or communication between the camera and
computer fails, or you connected the camera and computer before installing the software,
consult the items described below.

© For instructions on installing, refer to the “Software Guide” supplied with the camera.

Installation failed.

® Are you using Windows XP under a setting other than [Computer
administrator] privileges or using Windows 2000 under a setting other than

[Administrator] privileges?

- You cannot install software if a user setting other than [Computer administrator]
privileges or [Administrator] privileges is selected. Select the [Computer administrator]
privileges user setting in Windows XP or the [Administrator] privileges user setting in
Windows 2000. For detailed information on selecting the user setting, refer to your
computer’s instruction manual.

@ Is the cable firmly plugged into its socket?
- To complete the installation, ensure that the plugs on the dedicated cable are securely
plugged into the ports on the camera and computer when you connect the camera to
your computer.

® Are the camera and computer set up correctly for communication?

- |s the camera’s power switch set to <ON>?

- Even when the camera’s power switch is set to <ON>, operation of the Auto power off
function will automatically switch the camera off. To prevent this, set the Auto power off
function to [Off]. For more details, refer to the camera’s Instruction Manual supplied with
the camera.

® Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in
Windows 2000) dialog box appear during installation?
- Click the [Cancel] button, disconnect the dedicated cable, and then repeat the
installation procedure from the beginning.

® Doesn’t the installer panel appear?
- Use the following procedure to display the installer panel.
Click the [Start] button » [My Computer]. (In Windows 2000, double-click
[My Computer] on the desktop.) P click on the CD-ROM drive containing
the CD with the right button on the mouse P> select [Open] from the menu

that appears P double-click the icon on the right. SETUR

© Click on the item to display its page.

TroubleShOOting ......ccciiiiiiiir e ————————— 5-1
Uninstalling the SOftWare ... 5-3

Uninstalling the DIVET .........ooiiiiiiii e 5-3
Folder Structure and File Names ... 5-4
5 T 1= N 5-4

| have installed the software but the camera and
computer cannot communicate.

® Is the driver installed?

- The driver is required for communication between the camera and computer. When you
want to communicate between the camera and computer, be sure to install the driver
shown below appropriate to your windows.

» Windows XP: WIA Driver
» Windows 2000: TWAIN Driver

® Have you installed the WIA Driver or TWAIN Driver?
- Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed
unless the camera is connected to the computer. Insert the Solution Disk into the CD-ROM
drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your computer.

® Does your computer comply with these requirements?
B Cameras other than EOS-1D series cameras
- Computer with Windows XP or Windows 2000 preinstalled and equipped with a USB
port as a standard feature.
* Operation is not guaranteed when a connection is used on computer systems other
than those listed above.
B EOS-1D series cameras
- Computer with Windows XP or Windows 2000 preinstalled and equipped with an
OHCI-compliant IEEE1394 port.
* Operation is not guaranteed when a connection is used on computer systems other
than those listed above.

® Are the camera and computer connected correctly?
- Connect the camera to your computer correctly using the dedicated cable (p.1-3, p.1-4).

® Have you made the correct [Communication] settings for cameras that
require [Communication] settings?

- Set the camera’s [Communication] to [PC connect.] or [PC connection] for the EOS 5D
and EOS DIGITAL REBEL XT/350D DIGITAL, to [Print/PC] for the EOS 30D, and to
[Normal] for the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL (p.1-2).
* With the EOS 10D, you must also change the firmware to version 2.0.0 or later. For

details on changing, refer to the Canon’s web site.

5-1
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@ Is there sufficient charge left in the camera battery? - If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or Cover/Table of
- Your computer does not supply power to the camera. Connect the AC Adapter Kit [Unknown devices], the driver was not installed correctly. Use the following procedure to C t t
(optional) for the EOS 5D, EOS 30D, EOS 20D, EOS 10D, EOS DIGITAL REBEL XTi/ re-install the driver. ontents
400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL and EOS DIGITAL REBEL/ Delete the camera or [Canon Digital Camera] displayed in [Other devices] or L .
300D DIGITAL, the DC Coupler supplied with the camera for the EOS D60 and EOS [Unknown devices]. - ~
D30, and the DC Coupler Kit supplied with the camera for the EOS-1D series cameras. Disconnect the dedicated cable and delete the driver (p.5-3).
Alternatively, insert a fully charged battery and connect your computer and camera. Re-install the driver. |ntr0d uction
® Do you have more than one camera connected to your computer? L )
gggrl;éorr:gremc;mc-)re than one camera to the same computer, the driver and camera may not | connected the camera to the com puter before installing 3 )
- Exit the software and disconnect all the dedicated cables. Then connect only one the software .
camera to the same computer again. Downloadmg Images
@ Is the driver operating normally? @ Did you set the camera’s power switch to <ON>? from the Camera
Connect the camera to your computer ERe— - If you did not set the camera’s power switch to <ON>, proceed as follows: L )
with the dedicated cable and set the - gwf @ Disconnect the dedicated cable from the camera and computer.
camera’s power switch to <ON> and = 8 comuer Install the Solution Disk software on your computer using the correct installation ( ) )
open [Device Manager]. i Lo procedure and then connect the camera to your computer to complete the installation. Setting the Cameras
Click the plus symbol [+] to the left of I (e - If you set the camera’s power switch to <ON>, proceed as follows: otherthanthe EOS-1D
[Imaging devices] a_nd f:heck that the - O el o If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel] Series Cameras
connected camera is displayed. buttons to cancel all the dialog boxes. L )
- |f the connected camera is not 47 Mice and ather ponting devies 2 Set the camera’s power switch to <OFF>.
displayed, the driver is not operating -‘;”N”mtum Disconnect the dedicated cable from the camera and computer. r )
normally. 4 Install the Solution Disk software on your computer using the correct installation q
Briefly disconnect and then reconnect the dedicated cable, ensuring that the connection procedure and then connect the camera to your computer to complete the installation. Setting the EOS-1D
is secure. If the connected camera still does not appear, use the following procedure to Series Cameras
re-install the driver.
Disconnect the dedicated cable and delete the driver (p.5-3). To Display the Device Manager 2
Re-install the driver. .
i« di . @® Windows XP r N
e e s woescor e Gl e St cuton . sl Conol Panl . [Perarmance and Waiterance .
) C - ) ’ » [See basic information about your computer]. Then select the [Hardware] tab Remote Shootmg
Delete the camera displayed in [Imaging devices]. and click the [Device Manager] button.
Disconnect the dedicated cable and delete the driver (p.5-3). i
Re-install the driver. ® Windows 2000 L ’
. . - Click the [Start] button P> select [Settings] P> [Control Panel]. Then double-click the
®Is tCI;e d"Ver:' installed correctly? e ded 4 cable and set th [System] icon to open and select the [Hardware] tab and click the
- Connect the camera to your computer with the dedicated cable and set the camera’s [Device Manager] button. Troubleshooting

power switch to <ON> and open [Device Manager]. Click the plus symbol [+] to the left of
[Other devices] or [Unknown devices] and check whether the connected camera or
[Canon Digital Camera] is displayed.

I

Fie  Action Wew Help Fle Action Wiew Help

a 2 o= 2=
= = COMPUTER, = &) COMPUTER

-1 Computer - 1) Computer
< Disk.drives #] < Disk drives
#- @ Display adapters - & Display adapters
-2k DYDJCD-ROM drives b DDJCD-ROM drives
1 2 Flappy dsk cantralers 1 2 Flappy disk cantrollers
T3, Floppy dsk drives 1 33 Fieppy disk drives

(=% IDE ATA/ATAPI controllers 2 IDE ATA/ATAPI controllers

G [EEE 1394 Bus hest controllers S TEEE 1394 Bus host controllers

* L Keyboards #- % Keyboards

Mice and other pointing devices ® Mice and other pairting devices
o 5 monkors

3 1o

=Gk other devices.
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Uninstalling the Software

Log in under [Computer administrator]/[Administrator] privileges when uninstalling the
software.

Before starting the software uninstallation, exit all programs you are using and disconnect
the dedicated cable from your computer.

To prevent computer malfunctions, always restart your computer after you have uninstalled
the software. Re-installing the software without first restarting your computer is likely to
result in computer malfunctions.

Click the [Start] button P> select [All Programs] ([Programs] in
Windows 2000) » [Canon Utilities] » [EOS Utility] » [EOS Utility
Uninstall].

Proceed with the uninstallation as directed by the on-screen
messages.

Software is uninstalled.

Uninstalling the Driver

This section explains how to delete the driver for the EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS
5D, EOS 30D, EOS 20D, EOS DIGITAL REBEL XTi/400D DIGITAL, and EOS DIGITAL REBEL
XT/350D DIGITAL. If you are using EOS 30D or EOS DIGITAL REBEL XTi/400D DIGITAL in
Windows XP, it is not necessary to delete the driver as explained on this page because the OS
driver is used.
For deleting the driver for cameras other than those listed above, refer to the software
Instruction Manual supplied with the camera.
Log in under [Computer administrator]/[Administrator] privileges when uninstalling the
driver.
Before starting the driver uninstallation, exit all programs you are using and disconnect the
dedicated cable from your computer.

Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].

Your camera model is displayed in EOS XXX.

For Windows XP, click the [Start] button P> select [All Programs] P [Canon Utilities] P
[EOS XXX WIA Driver] P [WIA Driver Uninstall].

For Windows 2000, click the [Start] button P> select [Programs] B> [Canon Ultilities]
[EOS XXX TWAIN Driver] » [TWAIN Driver Uninstall].

Proceed with the uninstallation as directed by the on-screen
messages.

The driver is uninstalled.
2 Restart the computer.

® When the dialog box on the right appears,
select the [Yes, | want to restart my
computer now.] and click [Finish] button.
When the computer is restarted,
uninstalling of the driver is completed.

InstallShield Wizard

InstaliShield Wizard Complete

Driver unstalation finished. Restart computer
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Folder Structure and File Names

Images shot with the camera are saved in the memory card’s [DCIM] folder, with the following
folder structure and file names.

—

DCIM xxxCANON

Cameras other than EOS-1D series cameras

or File name Image type/Camera used
XxXEOS5D IMG_YYYY.JPG JPEG image
EOS 5D, EOS 30D, EOS 20D, EOS DIGITAL
IMG_YYYY.CR2 REBEL XTi/400D DIGITAL, EOS DIGITAL
RAW | REBEL XT/350D DIGITAL
image
EOS 10D, EOS DIGITAL REBEL/300D DIGITAL,
IMG_YYYY.CRW EOS D60, EOS D30
CRW_YYYY.THM Image for displaying the camera’s index

The “YYYY” in the file names represents a number between 0001 and 9999.

—(7

xxxEOS1D

EOS-1D series cameras

File name Image type/Camera used
*YYYY.JPG JPEG image
*YYYY.CR2 RAW | EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D Mark II
YYYY.TIF image | EOS-1Ds, EOS-1D
HYYYY. WAV Audio file

The camera specific character string set at the time of factory shipment
appears in “****” of the file name.

The camera specific character string set at the time of factory shipment or
set in the camera appears in “****” of images shot with the EOS-1D Mark II N.
The “YYYY” in the file names represents a number between 0001 and 9999.

CAI\%/ISC

The “xxx” in the folder names represent a number between 100 to 999.

The folder structure for the EOS-1D Mark Il N, EOS-1Ds Mark Il and EOS-1D Mark Il
CF card and SD card is the same.

When you perform DPOF settings on the camera, a [MISC] folder is created. The files
that manage the DPOF settings are saved in the [MISC] folder.

The folder that holds the image control files in the [DCIM] folder.

@ When Adobe RGB is specified, the file names of images shot with the EOS-1D Mark Il N,
EOS-1Ds Mark Il, EOS-1D Mark II, EOS 5D, EOS 30D, EOS 20D and EOS DIGITAL
REBEL XT/350D DIGITAL have an underbar “ _ " as the first character.
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